


CONTENTS <« 2 14

Contents

O 0 NI N Ul i W IN =

R
)

—_
N

Introduction. . ... 3
MultiRIP security . ... 3
System requirements . .......... .. 6
Installation . . ... 8
Sentinel LDK Security ......... ... 11
The Harlequin License Server. ......... ..., 14
Uninstall procedure ........... ..o i 18
Using the Harlequin RIP .. ... ... 18
Testing the Harlequin RIP . ... ... 19
Try Before You Buy licenses—HLSonly ............ ... .. ... . ... ... ... . ... 19
Expiring licenses . . ........... ... 23
Installing plugins . ............ . i 23

Copyright and Trademarks. ......... ... .. 24



INSTALLING THE HARLEQUIN® MULTIRIP™ FOR WINDOWS CONTENTS 4 3 14

Installing the Harlequin® MultiRIP" for
Windows

| Introduction

This document describes the procedure for installing the Harlequin® MultiRIP" (HMR)

v10.1r0 Release on Microsoft” Windows. To ensure trouble free installation of the Harlequin MultiRIP,
follow these instructions carefully. After installing, you may want to test the RIP is working correctly
by previewing a few fonts on screen. “Testing the Harlequin RIP” on page 19 describes how to do this.

Please note the following items about the Harlequin MultiRIP v10.1r0 Release:

¢ The NONE, TIFF and PDFRaster output plugins are installed at the same time as the Harlequin
MultiRIP. Other output plugins such as CIP3, OKI and TIFF/IT and the NTPipe input plugin are
supplied with their own installer. See “Installing plugins” on page 23 and the documentation
supplied with the plugin for more details.

¢ The Harlequin MultiRIP v10.1r0 is supplied as a 64-bit and 32-bit application.

*  You are provided with the option to choose either Sentinel LDK security or Harlequin License
Server (HLS) security with either software or hardware (dongle) licensing.

*  When using Sentinel LDK security the Sentinel LDK Runtime Environment is installed at the
same time as the Harlequin MultiRIP.

*  When using HLS the License Server is installed at the same time as the Harlequin MultiRIP. The
Harlequin MultiRIP v10.1r0 release must use v5.0r1 of the Harlequin License Server. For more
information, see “Harlequin License Server” on page 4.

¢ When using HLS the Harlequin License Manager application is provided to help manage your
licenses, and to allow the addition of extra permits. See “The License Manager” on page 17.

¢ When using HLS a Try Before You Buy option is available for RIP upgrades. For more informa-
tion, see “Try Before You Buy licenses—HLS only” on page 19.

Note: Plugins created for Harlequin Server RIP v9.x will work with 32-bit builds of HMR.

2 MultiRIP security

Global Graphics (GGSL) is replacing its RIP security application, the Harlequin License Server (HLS),
with a security system called the Sentinel License Development Kit (LDK) from SafeNet Inc. The
advantage of this system allows GGSL and OEMs to:

e  Provide a more robust security model, from a specialist security company.

e Enable a more timely and efficient delivery of RIP licenses to you, allowing flexibility and imme-
diate onward delivery without requiring that you hold large inventories.

e Allow GGSL to offer security variations as requested by some customers.

For new OEMs Sentinel LDK security is the recommended option, and HLS will be withdrawn in a
future version. A cross-over period from HLS to LDK is available to help with upgrades.

The Sentinel LDK can use either software or hardware protection. Software protection assigns the
product key to the machine running the RIP. Hardware protection assigns the product key to a hard-
ware dongle.
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2.1 Dongles

| The supported dongles for the Harlequin MultiRIP v10.1r0 Release are SuperPro (USB or Parallel).
Note: A 64-bit RIP will run with a 32-bit dongle, but a 32-bit RIP will not run with a 64-bit dongle.

2.2 Harlequin License Server

The Harlequin License Server is installed at the same time as the Harlequin MultiRIP. The Harlequin

| MultiRIP v10.110 release must use v5.0r1 of the HLS. Installation of the HLS is not an option and is
performed automatically. It is important that the dongle is plugged in before any attempt is made to
start the HLS. The HLS service automatically starts up when the computer boots up, and when the
Harlequin MultiRIP is started. You can, if you wish, manually start and stop the service. If the HLS
service is stopped, the RIP will not work.

If you have a supported dongle type, the License Server will read the dongle ID, ascertain that it is
valid, and give the RIP permission to run, by creating a valid “permit” which the RIP checks when it
starts up.

Note: A 64-bit RIP will run with a 32-bit dongle, but a 32-bit RIP will not run with a 64-bit dongle.

If you attempt to install an older version of the RIP after installing and using a v10.1r0 RIP, the v10.1r0
RIP will no longer work. This is because installing the older version of the RIP also replaces the
License Server. The v10.1r0 RIP requires the v5.0r1 License Server to work.

For more information, see “The Harlequin License Server” on page 14.

Note to OEM: The following sections (2.3, 2.3.1 and 2.3.2) describe the Licensing and
installment plan which you may want to remove or amend according to
your licensing model.

2.3 License model

The license model is extended to allow RIP customers to spread the cost of a RIP purchase over a
period (such as one year), and to be able to use it immediately while providing OEMs with the ability
to enforce regular payment. Once the full RIP price has been paid (after a year), the OEM can easily
enable the RIP to run from then on.

This licensing model is achieved by the use of a Licensing and installment plan which provides a combi-
nation of a recurring license period and a date at which the RIP customer gains an indefinite licence.
The length and number of recurring periods and the period before an indefinite licence is provided (if
ever), can be varied by the OEM.

Provision of the Licensing and installment plan option is subject to appropriate commercial agree-
ments.

The RIP customer is automatically warned when the current license period gets close to expiry.

In addition, the RIP customer can enable layered options and install encrypted fonts in the RIP run-
ning under an installment plan or leased licence.

If the lease or installment plan agreement for the RIP is terminated, all layered options are terminated
at the same time. The OEM does not need to enable leasing of layered options separately from the RIP.

It is possible to upgrade the RIP used under a lease licence without swapping out the dongle. It is not
necessary to swap out a dongle or any other hardware component for every license period.

OEMs will be charged the full cost of the RIP when the dongle/licence is initially delivered to them.

The solution provided allows OEMs (and dealers) to carry an inventory of any element that needs
physical shipping (such as dongles).
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2.3.1 Try Before You Buy upgrades—HLS only

When using Sentinel LDK security you can order a Timed product key allowing you to try layered
options before buying. For HLS security a Try Before You Buy option is provided.

A RIP customer with a RIP running under a Licensing and installment plan can evaluate layered options
under a TBYB license. It is not necessary to swap a dongle for every license period.

In addition, The RIP customer can return to their older RIP without requiring replacement of hard-
ware or re-configuration of the older RIP.

The RIP customer can build on the configuration applied in the upgrade version installed for the
TBYB as and when a permanent upgrade is purchased. The TBYB option is only provided for
upgrades on sites which are already running the RIP using a USB dongle. RIP customers with older
dongles (for example, parallel) should obtain a new dongle from their OEM.

Provision of the TBYB solution is subject to appropriate commercial agreements.

2.3.2 Demo dongles

Evaluation dongles for the Harlequin MultiRIP require permits to operate. 3, 6 month or 1 year time-
limited permits are available, and apply to all demonstration dongles already shipped. That is, dem-
onstration dongles will not work with v10.1r0 without a new permit.

Permits are available to OEMs who provide a list of demonstration dongles that are in active and legal
use.

The RIP customer is warned as the time remaining on the permit approaches expiry.

2.4 Changing the clock

Before installing the Harlequin MultiRIP together with the HLS, you must ensure the computer clock
is correctly set. Any change made to the computer clock after installation, specifically turning the
clock backwards so that the date is changed, may prevent the HLS from using permits. Launching
and running a dongled RIP will not be affected, but any function enabled through a permit may fail.

Note: Changes made to the clock to correct for small amounts of “drifting” and for daylight saving
will not affect the HLS.

2.5 Passwords

To get new passwords please contact either:

sales-admin-uk@globalgraphics.com
sales-admin-us@globalgraphics.com

You will need to provide the following information:

* Password, layered option, and name (from the Extra’s dialog box).

e  Serial number from RIP monitor on launch (Example: Serial number: 8373-46).
e  Part number from dongle label (Example: PS1-N-21-0BD-A?7).

Alternatively, if you are registered to use the eKey system you can obtain your password using the
online facility.
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3 System requirements

For optimum RIP performance, it is important for the computer running the Harlequin RIP to have a
good system specification, with plenty of free disk space, a powerful processor and ample system
memory. Refer to Table 1 for the minimum system specifications for running the Harlequin RIP. Also,
you should not run other processor/memory intensive applications when the RIP is processing jobs,
as they could slow down the performance of the RIP.

The Harlequin RIP OEM Manual for Windows operating systems describes the features of the RIP that can
affect throughput and shows how you can improve performance. See Chapter 2, “Running the
Harlequin RIP” in the Harlequin RIP manual for details.

Note to OEMs: The mention of Chapter 2, “Running the Harlequin RIP”, may need
manual editing in your versions of the installation guide.

Component Recommended and minimum requirements (R or M)
Processor Any core-I processor at 2 GHz or faster, or AMD equivalent R
Operating system 32-bit HMR is supported on:

e  Windows 7 SP1 (excludes Starter edition)
e  Windows 8.1 (excludes Windows RT)
64-bit HMR is supported on:

e  Windows 7 SP1 (excludes Starter edition)
e  Windows 8.1 (excludes Windows RT)

e Windows Server 2008 R2 (requires SP1, Standard edition
only, excludes Server Core configuration)

e  Windows Sever 2012 R2 (Standard edition only, excludes
Server Core configuration)

Hard drive 32 GiB or larger, preferably 7200 RPM or higher M
System requirements 4 GiB RAM if not using TrapPro; 8 GiB RAM when using R
TrapPro.
Note: The use of more than 4 GiB RAM implies a 64-bit RIP
build

Note: You may want to amend this value to account for your
particular plugin requirements

Port Parallel / USB port for the Sentinel security dongle unless using | M
the LDK
Note: Amend the port type depending on which dongle you
supply

Network Access via wired connection or WiFi for job submission and R
licence activation

Minimum monitor 1280 x 1024 or higher resolution M

specification

Table | Harlequin MultiRIP recommended and minimum requirements
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Component Recommended and minimum requirements (R or M)

Sentinel LDK The LDK Admin Control Centre (ACC) requires a web browser:| M

¢ Internet Explorer 8.0 or later

e  Mozilla Firefox latest version

Table | Harlequin MultiRIP recommended and minimum requirements
Note: HMR v10.110 (or later) is not supported on Windows XP, Windows 8 and Windows Server
2012.
Note: HMR v10.0r0 (or later) is not supported on Mac OS X or Linux.

Note: For output devices running at higher resolutions, larger formats, more colorants, or those that
run at high speed, more RAM, more disk space and a higher specification CPUs is highly recom-
mended.

Note: You should increase the band memory size, using the Configure RIP Options > Band memory per
thread value, when core halftone modules are installed. That is, when the screening is done in OEM
code as a plugin.

3.1 Special notes

This section contains useful information you should note before installing the RIP.

3.1.1 Memory considerations

When using a 32-bit version of the Harlequin MultiRIP on Windows XP or Windows 7 you must add
the /73GB switch to the Boot. ini file if you want the machine to make use of memory greater than 2
GiB.

Use the following process:
1. Make sure you remove the read-only attribute of boot.ini (if there is one) before editing the file.

2. Add /3GB /USERVA = 3030 to the end of the line that begins:
multi (0)disk(0) --....

3. Reboot the machine.

If the RIP has been started prior to adding the /3GB switch, the size of the available address space
stored in SW/Config/ConfigureRIP will be incorrect. To reset the RIP’s memory size after adding the
/36GB switch, you should change the /MaxAddressSpaceSize value to 0; the RIP will then determine the
new size automatically.

4. Edit /MaxAddressSpaceSize in the file SW/Config/ConfigureRIP to read:
/MaxAddressSpace Size 0

5. Start the RIP. Check the Memory Statistics. You should be seeing more than 2 GiB under “Mem-
ory Available for RIP”.

If you require more information about the Boot.ini file, an article titled “Reviewing and Correcting
Boot. ini Settings on x86-based Systems” is available on www.microsoft.com.

Similarly, If you downgrade from a 3 GiB capable OS to a 2 GiB OS (for example, by removing the
/36GB switch), the memory size information in the RIP configuration will be wrong and will cause
problems. Manually edit SW/Config/ConfigureRIP to set the /MaxAddressSpaceSize value to 0; this will
cause the RIP to redetermine the address space size.



http://technet2.microsoft.com/windowsserver/en/library/5c0dc5e4-3467-4f35-ab25-c58f1e096e821033.mspx?mfr=true
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Using Migrate will reset the /MaxAddressSpaceSize value to 0 (zero).

4 |nstallation

This section describes how to install the Harlequin RIP and its associated products on Windows oper-
ating systems. Close all other applications before installing the Harlequin RIP.

When using the Sentinel LDK the summary of the installation procedure is:
1. When installing a new RIP make sure you have your product key.

2. Ifyou are upgrading your RIP and have previously installed using the Sentinel LDK security and
your product key is still valid your RIP will detect this and will automatically be enabled.

3. Previous installations of the Harlequin MultiRIP and any application using the LDK must be
shutdown before attempting to install a new RIP.

4. Run the InstallAnywhere package, and install the RIP, plus any other plugins you need. See
“Installation procedure” on page 8.

Note: If you are using Sentinel LDK security with a dongle note that the dongle drivers are loaded
along with the LDK.

5. Make sure the LDK is installed.
When using the Harlequin License Server the summary of the installation procedure is:
1. Make sure the dongles are unplugged before commencing the driver installation.

2. Previous installations of the Harlequin MultiRIP and any application using the HLS must be
shutdown before attempting to install a new RIP.

3. Make sure the computer clock is set correctly. See “Changing the clock” on page 5 for the reason.

4. The HLS must be stopped before attempting to install a new RIP. See “Starting and stopping
HLS” on page 16 for more information. On Windows platforms the HLS is automatically shut
down by the installer.

5. Run the InstallAnywhere package, and install the RIP and dongle drivers, plus any other plugins
you need. See “Installation procedure” on page 8.

6. Load the dongle drivers. See “Loading the dongle drivers—HLS only” on page 10.
7. Start the HLS service. On Windows platforms the HLS is automatically started by the RIP.
8. Start the RIP. See “Starting the Harlequin RIP” on page 18.

4.1 Installation procedure

When installing it is recommended that you:
¢ Install the RIP as an Administrator.

*  Run the RIP as a User.

e To do this, the relevant read, write and execute permissions need to be set for a designated
group, whose members are able to run the RIP.

This is a manual operation which involves setting up groups and adding users as members to those
groups, then changing the permissions of the RIP directories accordingly.

For example:
1. Use Computer Management to create a new user group called, for example, RIPusers.

If necessary, refer to the System Help for details on how to create a new user group.
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Add the Administrator and any RIP users as members of that group.
Install the RIP as Administrator (see below for details).

As Administrator still, change the top-level directory of the Harlequin RIP (and all enclosed files
and directories) to have read, write and execute permissions for the group called RIPusers.

Any user belonging to the RIPUsers group will be able to run the RIP.

Once you have set up a user group as described above, you can install the Harlequin RIP.

Double-click install HMR_winXX.exe (Where XX is either 64 or 32) to load the InstallAnywhere product
installer, which allows you to easily install the Harlequin MultiRIP products. There is usually a pause
after double-clicking the .exe before any dialog is displayed. This is because a Java virtual machine is
installed as part of the installation process.

1.

To ensure you have the necessary privileges for installing the Harlequin RIP, log on as System
Administrator or right-click the installer and select Run as administrator.

Note: If a User Account Control message appears ensure that the program is the Harlequin MultiRIP
installer and select Yes. Otherwise select No.

2.

4a.

4b.

Follow the InstallAnywhere screen instructions. Select the Next button to move onto the next
screen and the Previous button to return to a previous screen. Note that each screen of the install
procedure is labelled both above and at the left side of the window.

In the “Select Product” screen choose either Harlequin MultiRIP using Sentinel LDK or Harlequin
MultiRIP using Harlequin Licence Server.

If you have chosen to install the RIP with licensing performed using the Sentinel LDK you are
presented with the following options:

RIP and LDK together
Use this option to install both the RIP and the LDK.

RIP only (will use a remote LDK)

Use this option to install only the RIP components. Licensing is per-
formed using an LDK installed on another machine on the network.

LDK only (for use with remote RIP)

Use this option to install only the Sentinel LDK components. In this case
the RIP is installed on another machine on the network and this
machine is providing the licensing capabilities.

If you have chosen to install the RIP with licencing performed using the Harlequin License Server
you are presented with the following options:

RIP and HLS together

Use this option to install both the RIP and the HLS along with an option
to a install the dongle driver. It is recommended that you leave this
option checked. if you choose not to install the dongle drivers at this
time you must do so before attempting to use the RIP. For more informa-
tion see “Loading the dongle drivers—HLS only” on page 10.

RIP only (will use an existing HLS)

Use this option to install only the RIP components. Licensing is per-
formed using an existing HLS installation.

HLS only (RIP will be installed separately)
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Use this option to install only the HLS components. In this case the RIP
is installed separately.

5. Use the “Choose Install Folder” screen to select an installation folder.

If you wish you can choose a different install folder to the default. Click Choose... and navigate to
the required folder. If at any time you wish to restore the default location click Restore Default
Folder. Click Next to install in the desired location and move onto the next stage.

6. Use the “Choose Shortcut Folder” screen to create any icons or Start menu options.

Note: If you have chosen to install the RIP in a different directory to the default directory, you
will not be able to create icons in this directory unless you have created it before starting the
installation. When this is done click Next.

7. The “Pre-Installation Summary” screen allows you to examine your installation choices. If
required, use the Previous button to return to earlier screens and modify your selections, other-
wise click Install to proceed with the installation.

8a. If you are using the HLS a warning dialog may be displayed at this point. Any products on your
system that use the Harlequin License Server should be stopped before continuing with the
installation. Click Continue to move ahead with the installation. Previous versions of the HLS will
now be removed.

8b. If you are using the LDK a dialog is displayed allowing you to enter the product key or to skip
that step. If you have previously entered a product key and it is still valid, skip this step and your
RIP will run without the need to re-enter the key. For the product key to be registered the Sentinel
LDK runtime environment must be installed on the RIP computer. This is done automatically as
part of the RIP installation. If you do choose to enter your product key the LDK tool appears. See
“Using the LDK licensing tool” on page 12 for the full procedure.

9. The installation will now continue. This may take some minutes. The time taken depends on the
number of options to be installed. A progress indicator is displayed at the bottom of the dialog
box.

10. The “Install Complete” screen indicates that the installer has finished. If any errors have occurred
a message will be displayed. Click Done to exit from the installer. You can view the details of the
errors by opening the xx_InstallLog.xml file which is located in the installation folder. The install
log file is created even if the installation is error free.

Note: This log file is only created after Done is clicked —but the message to examine that file is
displayed in the “Install Complete” dialog—so it is possible to navigate to the directory and not
find the logfile (if Done has not been clicked first).

You can search for installation errors in this document by searching for the word “warning”.

4.2 Loading the dongle drivers—HLS only

If you are using the Harlequin License Server and you chose not to install the dongle drivers as part of
the installation procedure you must manually load the dongle drivers. This section describes how to
load the required dongle drivers.

| Harlequin MultiRIP v10.1r0 must use version 7.5.7 of the Sentinel dongle driver.

1. The security dongle supplied with the Harlequin RIP has its own set of drivers. These must be
installed and loaded if the dongle is to allow the RIP to load successfully. If you have not already
done so, add them from the drivers package (as described in “Installation procedure” on page 8)
and proceed as follows:
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SentinelSystem Driver Installer XXX.exe file (where XXX is the version) in the sentinel folder within
the Harlequin RIP installation.

| 2. If, following the installation procedure you decide to unload the dongle drivers, you will find the

3. Ifyoudecided not to unload the dongle drivers, you can either go back and rerun the .exe installer
to add the drivers. Alternatively, you will find the dongle driver installer located within the
sentinel folder.

4. After installing the RIP and unloading the dongle drivers you should do a complete install of the
Sentinel drivers using the Sentinel System Driver Installer XXX.exe file in \sentinel.

5. Restart your computer after installing the drivers.

You must now enable your RIP and features using your chosen security option. See “Sentinel LDK
Security” on page 11 or”The Harlequin License Server” on page 14.

4.3 Security preferences

A SWisecprefs file is created during the installation, and it informs the RIP which security option to use
when both LDK and HLS are installed on a system. This could happen if the machine is being used
with other GGSL products. In this situation the SWsecprefs file can be edited so that either LDK or
HLS is used.

To use LDK security the SWisecprefs file contents should be:

method
1dk

To use HLS security the SWisecprefs file contents should be:

method
hls

Note: When migrating from HMR 10.x with HLS to HMR 10.x with LDK, if you don’t re-install the
RIP, you must change the SWisecprefs file to indicate that the RIP should use LDK instead of HLS after
the migration. The SWisecprefs file is created during the installation, and it informs the RIP which
security option to use when both LDK and HLS are installed on a system.

4.4 Transition from HLS to LDK

When performing the transition from HMR 10.x with HLS to HMR 10.x with LDK the LDK runtime
and components must be installed and the SWisecprefs file must be changed. Therefore, it is recom-
mended that you perform a new install in a new location and select LDK for the security. You can then
use the backup configuration and fonts tools to move data across from a pre-existing RIP.

If, however, you wish to transition your current installation, that is replace HMR 10.x with HLS with
HMR 10.x with LDK on the same RIP, you must install the LDK runtime and components using the
installer and change the SWisecprefs file to indicate that the RIP should use LDK security instead of
HLS after the transition. The SWisecprefs file is created during the installation, and it informs the RIP
which security option to use when both LDK and HLS are installed on a system.

5 Sentinel LDK Security

For details on Sentinel LDK security see the FAQ document entitled LDK Security for Harlequin
MultiRIP 10. For more information on the LDK utilities see Technical note HQN091.
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5.1 Using the LDK licensing tool

The LDK licensing tool is a straight-forward utility for licensing, upgrading and transferring your RIP
licenses. The following information is provided:

5.2 License a new RIP—software protection

1. Make sure you have received your product key from Global Graphics.
2. Make sure you have an internet connection.
3. Install the Harlequin MultiRIP using the normal installer.

Note: The Sentinel LDK runtime environment should be installed on the RIP computer before gener-
ating a fingerprint or transfer recipient file for it.

Note: If RIP machine does not have web access you must copy the ldktool.exe located at
<HarlequinMultiRIP_XXX>\Idk\utils\ onto a machine with web access. The LDK tool provides various
options which enable product activation and upgrade and is available as an easy to follow graphical
user interface.

4. Todisplay the LDK tool select LDK registration from the Start menu. Or assuming a default install,
go to \users\<name>\<HarlequinMultiRIP_XXX>\dk\utils\ and double-click 1dktool.exe.

Where <HarlequinMultiRIP_XXX> is your HMR name:

File Help

Create a new RIF license for this computer which uses a software key:

Product Key: Activate...

If ywou are activating this computer for the firsttime, and you have interet access. enter
wour Product Key above and click "Activate'.

Ifyou need to configure an internet proxy server, select Settings from the File menu first. Display Keys

For other operations please click "Mare..".
taore...

ik

Figure |  LDK (new RIP) tool

5a. If this machine running the RIP has web access, select Have internet access.

Copy and paste the product key into the Product Key field and select Activate. An “Are you
Sure...” message appears.

If you are sure click Yes. If you are not sure select No.
This creates a local key assigning your products to the machine.

| 5b. If this machine running the RIP does not have web access select More > New License > License this
computer > No internet access. You are prompted to create a fingerprint file (C2V) for this com-
puter.

Select Create. A browser opens allowing you to Save a file called <machine name>.fingerprint.c2v.
When the file is saved click OK in the dialog. A dialog with a Locate option is displayed. Leave
this dialog open and move the <machine name>.fingerprint.c2v file, using a network or memory
stick, to a machine with web access.
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On the machine with web access start the LDK tool and select New License followed by License a
different computer. Paste your key into the Product Key field and click Activate. This displays a
browser allowing you to select the previously created fingerprint file.

On selection of the fingerprint file another browser opens allowing you to save a <machine
name>.license.v2c file. Select this file and select Save.

Move the <machine name>.license.v2c file to machine running the RIP. That is, the machine with the
dialog displaying the Locate button. Select the Locate option. A browser appears. Select the
<machine name>.license.v2c file. Otherwise click Cancel.

When completed an “Activation successful” message appears.

To open the Sentinel Admin Control Center double-click the shortcut located in
<HarlequinMultiRIP_XXX>\Idk\utils. Alternatively, start your browser and enter:

http://localhost:1947

The Sentinel Admin Control Center tool provides useful administration and control capabilities.

5.3 Upgrade your RIP and add new options

If you are upgrading you RIP and want to add a new option:

1.

2
3.
4

5.

Make sure you have received your product key from Global Graphics.
Make sure you have an internet connection.
Install the Harlequin MultiRIP using the normal installer.

To display the LDK tool select LDK registration from the Start menu. Or assuming a default install,
go to \users\<name>\<HarlequinMultiRIP_XXX>\dk\utils\ and double-click 1dktool.exe.

Where <HarlequinMultiRIP_XXX> is your HMR name:

& LDK Tool e S

File Help

Add options to an existing RIF license for this computer:

Product Key: || Activate...

| KeylD: |319877557363073890 =
Display Keys

Mare...

ik

Figure 2 LDK (add options) tool

If you have a new key to add new options to your RIP for this computer enter it into the Product
Key window and click Activate. (You can select another Key ID using the down-arrow in Key ID
window.)

Note: Select More... to display extra LDK tool options.
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5.4 License a new RIP—hardware protection

1. Make sure you have received your product key from Global Graphics.
2. Make sure the dongle is plugged into the computer running the RIP.
3. Install the Harlequin RIP using the normal installer.

Note: The Sentinel LDK runtime environment should be installed on the RIP computer before gener-
ating a fingerprint or transfer recipient file for it.

4. Go to <HarlequinMultiRIP_XXX>\ldk\utils\ and double-click Idktool.exe. Where
<HarlequinMultiRIP_XXX> is your RIP name.

5. Copy and paste the product key into the Product Key field and select Activate. An “Are you
Sure...” message appears.

If you are sure click Yes. If you are not sure select No.

This creates a local key assigning your products to the dongle.

5.5 Location of the Sentinel LDK components

After installation, the LDK components can be found in the following locations:

haspdinst.exe Installer for the Sentinel LDK | \C:\Users\<name>\HMR_10_X_XXXX\1dk\
runtime environment.

Idktool.exe Sentinel LDK tool with a C:\Users\<name>\HMR_10_X_XXXX\Idk\utils
graphic user interface.
Idkutil.exe LDK command line utility. C:\Users\<name>\HMR_10_X_XXXX\Ildk\utils

Sentinel Admin | Shortcut for starting the Senti- |C:\Users\<name>\HMR_10_X_XXXX\1dk\utils
Control Center |nel Admin Control Center.

Table 2 Sentinel LDK components

5.6 Sentinel LDK notes

When you install a new RIP using the LDK and you activate your product key, the RIP will run.

If you uninstall the RIP and remove the LDK runtime and then re-install the RIP and LDK runtime
using the “skip this step...” option when prompted to enter the key, the RIP should run because the SL
key should still be present.

If, however, the RIP does not run, claiming that no licenses are available, you should re-start the Sen-
tinel Local License Manager service. To do this, right-click Computer and select Manage. Select Services
and Applications in the left windows followed by double-clicking Services in the right window. This dis-
plays all the available services. Scroll down and select Sentinel Local License Manager followed by
Restart.

Generally, if you have a problem with the RIP not starting and you have already activated your prod-
uct key, restart the Sentinel Local License Manager service.

6 The Harlequin License Server

This section describes how to add new permit files and how to start and stop the HLS (Harlequin
License Server) service. For more information on adding permit files, see “Adding a permit file to
HLS” on page 17. The easiest way to start the service is to restart the machine. However, if this is not
convenient, alternative methods exist and these are described in “The removal of the RIP will
commence. When the “Uninstall Complete” message appears click the Done button.” on page 18.
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6.1 Permit files and licenses

The Harlequin MultiRIP can be enabled in either of two ways:

* Using a dongle (and optionally a permit) for a Harlequin Server RIP 8.2 or earlier release, with
an appropriate upgrade password installed into every RIP instance.

* Using a dongle (and optionally a permit) specifically created for the Harlequin MultiRIP v3.0.

Global Graphics’ products are certified to run by licenses. Licenses are provided via permit files or by
dongles. Without a license the product is not permitted to start, resulting in the following typical error
messages:

License Server failure (0OxC8001005): permit for this software not available

License Server failure (0xC8001006): no free licenses available.

6.2 About permit files and licenses

Permit files may contain multiple licenses. Each license allows one instance of the product to start. For
example, if a permit contains two licenses for a product, two instances of that product are allowed to
run concurrently.

For the Harlequin RIP, if you have a supported dongle type, the License Server will read the dongle
ID, ascertain that it is valid, and give the RIP permission to run, by creating a valid “permit” which
the RIP checks when it starts up. That is, the dongle provides a permit containing a single license for
one RIP. All other RIP instances require a permit file containing the required number of licenses.

Note: Permit files and licenses do not enable additional Harlequin MultiRIP options like TrapPro,
ColorPro and printer plugins. These features are enabled in the RIP by entering a valid password in
the Configure RIP Extras dialog box.

6.2.1 How authorization works
Product authorization is obtained from the dongle attached to the computer.

Every permit file issued by Global Graphics is “keyed” to a specific HLS host server or servers. These
servers are identified in the permit files, using the IP address, dongle number and/or machine ID of
the HLS host. A permit file may not therefore be used on any machine whose dongle, ID or IP address
is not known.

Permits generally have a very long expiry date. However, 30-day permits exist which are used to limit
the life span of Try Before You Buy features in the Harlequin RIP.

Note to OEM: For more information on these options, see the document: Ordering RIP
Products Including Try Before You Buy Options - Technical Note Hgn 059.

Note: If you change the dongle on a machine, it changes the HLS unique ID. Thus, if you have any
permit files keyed to the unique ID of the previous dongle, those permit files will not be valid with the
new dongle. So, if you have for example a JDF Enabler permit file keyed to donglel, that would not be
valid for use with dongle2. Swapping to dongle2 would prevent your JDF Enabler from working.

6.2.2 Re-using licenses

Licenses are released and are available for re-issue when a product is closed or after an abnormal pro-
gram termination occurs. If the product and HLS are running on the same machine, the license is
immediately available for re-issue when a product is closed. However, in cases where HLS and the
product are installed on different machines, the license may not be available for up to two minutes
after a product is closed.
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For information on the HLS, you can examine the hls_1log file. See Table 3 for more details.

6.2.4 Location of the Harlequin License Server components

After installation, the HLS components can be found in the following locations:

HLS program \Program Files\Common Files\Global Graphics Software\Harlequin
License Server\

License Manager | \Program Files\Common Files\Global Graphics Software\License
Manager

Permit files \Program Files\Common Files\Global Graphics Software\Harlequin
License Server Permits

Log file \Program Files\Common Files\Global Graphics Software\hls.log

Table 3 HLS components

6.3 Starting and stopping HLS

The HLS service (HarlequinLicenseServer) starts automatically when Windows loads and when the
RIP is started. To start and stop the service manually, do the following:

1. In Windows, open Control Panel > Administrative Tools > Services. The Services window opens
showing all your services.

2. From the list, right-click Harlequin License Server and select Start or Stop from the shortcut menu
that opens. The Service Control window appears briefly as the service is started or stopped.

3. Close all open windows to finish the procedure.

Alternatively, the HLS can be started and stopped from the command line:

1. To start the HLS open a command prompt window and enter:

net start ‘“HarlequinLicenceServer”

The following message will appear:

The Harlequin

License Server service is starting...

The Harlequin License Server service was started successfully.

1. To stop the HLS open a command prompt window and enter:

net stop “HarlequinLicenceServer”

The following message will appear:

The Harlequin

License Server service is stopping...

The Harlequin License Server service was stopped successfully.
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If you move hgn_Isd.exe from its original installation folder, the Harlequin License Server service
will be prevented from starting and stopping. To resolve this problem you must remove the service
with the command:

\<path to HLS>\hgn_Isd -remove
and then install it with the command:
\<path to HLS>\hgn_Isd -install

After doing this, you may start and stop the HLS service as described above.

Note: The -install option may be useful if you think you have installed the HLS, but it does not
appear as a Service within the Administrative Tools. Using the -install command will make the ser-
vice appear.

6.4 The License Manager

The License Manager allows you to view license information, and to see which of your HLS host
machines are running, both locally and on the network. You can also use the License Manager to add
new permit files and to open the HLS log file.

For the License Manager to work the Harlequin License Server must be running. See “The removal of
the RIP will commence. When the “Uninstall Complete” message appears click the Done button.” on
page 18 for more information.

6.4.1 Starting the License Manager
To start the License Manager:
Select Start > All Programs > Global Graphics > <RIP Version> > License Manager.

After a slight delay, during which time the application searches for the HLS hosts, the application
window opens.

6.4.2 Obtaining your machine identity

The Harlequin License Manager displays the ID and IP address of a machine (in the Host Info win-
dow) as well as the dongle security number, OEM customer number and the products enabled by the
dongle (in the Dongle Info window).

Note: If you are running a Harlequin MultiRIP, you can also find the ID of the dongle by looking at
the Harlequin RIP > Configure RIP > Extras dialog box. The number you require is displayed in the Trial
code field.

6.4.3 Adding a permit file to HLS

You can use the License Manager utility to add new permit files to the HLS host that is running on the
same machine. The License Manager does not allow you to add permits to HLS hosts running on
remotely connected servers.

To add a new permit file, select the local server in the Server list and click the Add Permit button, and
then select the permit file you wish to add. After adding a new permit file, HLS automatically re-ini-
tializes itself and updates the license information for the new permit file you have just added.

The License Manager displays the currently available permit files. See “Location of the Harlequin
License Server components” on page 16 for the location of the permit files.
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7 Uninstall procedure

This section describes how to uninstall the Harlequin MultiRIP.

7.1 Uninstalling the RIP

Before uninstalling ensure you have the necessary privileges by logging on as System Administrator.

1. Navigate to:
<install directory>\Uninstall Harlequin MultiRIP 10.XrX (Generic)

2. Double click on the uninstall icon, or right-click and select Run as administrator. The Uninstall
dialog box will be displayed. Click Uninstall to complete the process. Note that the Uninstall pro-
cess will not remove any folders or files created after the installation.

Note: If a User Account Control message appears ensure that the program is the Harlequin MultiRIP
uninstaller and select Yes. Otherwise select No.

3. The removal of the RIP will commence. When the “Uninstall Complete” message appears click
the Done button.

8 Using the Harlequin RIP

After installing the Harlequin RIP, and loading the dongle drivers, you may start the RIP and start to
process print jobs.

Note: Immediately after installation and before attempting to use the RIP you should ensure that the
dongle is attached.

8.1 Starting the Harlequin RIP

To start the Harlequin RIP:

1.  If the security dongle is not attached to the computer, you should make sure it is attached.

2. To start the RIP, select:
Start > All Programs > Global Graphics > Harlequin RIP X.X <customer name> > License Server MT RIP
or
Start > All Programs > <OEM name> > <RIP name> > <RIP.exe name>

depending on the installation.
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3. Ifitis the first time the RIP has been loaded, the Select User Interface Language window opens,
as shown in Figure 3. From the list choose the user interface language to use for dialog screens,
messages and menus in the RIP. If your preferred language is not enabled, click Enable and enter
the password when prompted (your supplier can provide you with a password if you do not

have one).

Select User Interface Language

S

Language Meszages  Resource: Locale

Japanesze [lapan] Prezent Prezent Mizzing
Englizh [United Kingdom] Present Fresent Fresent
Englizh [United States]  Present Present Present

Enabled
Mo
es
.'I'.IEE:

Enable... [ o | [ ok ]

Cancel

Figure 3  Select user-interface language

4. Click OK after choosing the language. The RIP loads and is now ready for use.

9 Testing the Harlequin RIP

To confirm the Harlequin RIP is installed and working correctly, we suggest that you proof some fonts
on screen. The following procedure describes how to do this:

1. In the Harlequin RIP choose Fonts > Proof Fonts. The Proof Highlighted Fonts window opens.

2. From the list, select four or five fonts (using the Ctrl key) and then click Proof. The fonts are
rasterized and the results are displayed on screen, as shown in Figure 4.

Palatino-ltalic

abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQR

1234567890-=1@#$%"&*()_

Figure 4 Proof fonts

If this test completes satisfactorily the Harlequin RIP is working correctly.

|0 Try Before You Buy licenses—HLS only

When using Sentinel LDK security you can order a Timed product key allowing you to try layered
options before buying. For HLS security a Try Before You Buy option is provided.

If you would like to make use of a Try Before You Buy feature, you should contact your supplier and
request a license. You will be asked to provide the following information:

®  Serial number of your dongle. This is a five digit number.

*  Security number of your dongle. This is a four or five digit number with a two digit checksum
written on your dongle. It is also displayed in your Harlequin RIP monitor during start-up.

14


http://www.redhat.com/docs/manuals/enterprise/RHEL-5-manual/Deployment_Guide-en-US/index.html
http://www.redhat.com/docs/manuals/enterprise/RHEL-5-manual/Deployment_Guide-en-US/index.html

INSTALLING THE HARLEQUIN® MULTIRIP™ FOR WINDOWS CONTENTS 4 20 14

¢ Trial code. This code is displayed in the Harlequin RIP > Configure RIP > Extras dialog box in the
Trial code field.

See “Obtaining your machine identity” on page 17 for more information on how to obtain these
numbers.

After you have provided this information, a . tbyb file will be sent to you.

10.1 Installing Try Before You Buy licenses

Use the following procedure if you are have a v8.0 dongle (for example) and want to use a Try Before
You Buy license for a RIP upgrade to a MultiRIP version:

1. Click Try... in the Revision Password dialog.

2. Select the Try Before You Buy installation file. Once selected the Try Before You Buy permit is
installed, HLS is restarted and the revision password is displayed in the Revision Password dia-
log.

3. Click OK to start the RIP. Any other passwords in the Try Before You Buy installation file are read
as the RIP starts up and a confirmation dialog is displayed.

The following procedure describes how to install a Try Before You Buy license in the Harlequin RIP.

1. Inthe RIP, open the Configure RIP Extras dialog box (Figure 5) by clicking Harlequin RIP >
Configure RIP > Extras.

Configure RIP Extras | RS |
Feature Enabled
HCS - Chained Screening Mo =
HPS - Precision Screening Yes Add...
HxM - Crozs-Modulated Screening Mo |
HOLT - Harlequin display list technology Mo
TrapPro Mo
TIFFAT Mo
Harlequin CalorPro Mo i
Dlmn b mrim b e
Try Before You Buy

Trial code: 3229229229

Ealuation iz not enabled Try...

Figure 5 The Configure RIP Extras dialog box

2. Click the Try button and navigate to your Try Before You Buy license (<file name>.tbyb) that has
been e-mailed to you. If the Try button is not available, see “Manually installing a Try Before You
Buy license” on page 21.

3. Select the . tbyb file. If the installation is successful the following message appears:

Try Before You Buy installed successfully
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Click OK to remove the message. The enabled trial options now show Trial in the Enabled
column.

Configure RIP Extras | E

Feature Enabled i

HCS - Chained Screening Mo E

HPS - Precision Screening Yes Add...
HxM - Crozs-Modulated Screening Mo |

HOLT - Harlequin dizplay list technalogy Mo

TrapPro Mo

TIFFAT Mo

Harlequin CalorPro Mo i

Dlmn b mrim b e

Try Before You Buy

Trial code: 3229229229

Evaluation period remaining 30 days.
1

Try...

Remaining trial

period

Figure 6 Configure RIP Extras dialog box showing trial features

4. Click OK until all open dialog boxes are closed to complete the procedure.
5. Restart your RIP.

The remaining period for the trial options is shown in the monitor window when the RIP starts and in
the Configure RIP Extras dialog box.

When you install a TBYB file, two things occur:
® apermitis added to the License Server
® passwords are set

Therefore, if you decide to select Cancel in any of the dialogs displayed after the Extras dialogs, the
Trial will not be enabled. Cancelling will un-set the passwords, but the License Server will still have
the permit. In this case, TBYB is still enabled but you are, in effect, evaluating no features, hence the
message:

Evaluation period will expire in <n> days

where <n> is the number of days.

10.2 Manually installing a Try Before You Buy license

The following instructions describe how to manually install a Try Before You Buy license in the RIP.
You may have to do this if the Try button in the Configure RIP Extras dialog box is unavailable, which
occurs when the RIP and the Harlequin License Server (HLS) are installed on different machines.

To install a Try Before You Buy license manually, do the following;:
1. Open the Try Before You Buy license in a text editor.

2. Copy the information between <Permit data starts> and <Permit data ends> into a new text
file. Save the new text file with the name called TBYB.hgn.permit.

3. Copy the information between <Password data starts>and <Password data ends>into a new
text file. Save the new text file with the name TBYB. pwd.

4.  On the machine where HLS is installed, open your HLS permits folder, or create the folder if it
does not already exist. The folder is located in the following place:

\Program Files\Common Files\Global Graphics Software\Harlequin License Server
Permits\



INSTALLING THE HARLEQUIN® MULTIRIP™ FOR WINDOWS CONTENTS 4 22 14

5. Place the file TBYB.hgn.permit in the permits folder and then restart the computer.

6.  On the machine where the RIP is installed, open the RIP passwords folder:
<Harlequin RIP install folder>\SW\Passwords

and add the file TBYB. pwd.
7. Restart the RIP.

The Try Before You Buy features are now enabled in the RIP. The remaining evaluation period for the
trial features is displayed in the RIP monitor window when the RIP loads, and in the Configure RIP
Extras dialog box.

10.3 Post installation Try Before You Buy RIP messages

After installing a Try Before You Buy license, the Harlequin MultiRIP monitor displays the following
helpful messages:

Try Before You Buy evaluation period will expire in <n> days
On the day the license is due to expire:

Try Before You Buy evaluation period expires today
And after the license has expired:

Try Before You Buy evaluation period has expired

10.4 Removing Try Before You Buy options

If you need to remove the Try Before You Buy options from a RIP, you can do this using the following
procedure:

1. Shutdown the RIP.

2. Stop the License Server. See “The removal of the RIP will commence. When the “Uninstall
Complete” message appears click the Done button.” on page 18.

3. Move the files labeled tbyb. installed.hqgn.permit files from the following folder to a safe
location:

\Program Files\Common Files\Global Graphics Software\Harlequin License Server
Permits\

4. Move the files of the form: xxxxx-tbyb. installed.004 from the following folder to a safe
location:

<installation folder>\SW\Passwords

5. Restart the License Server, see “The removal of the RIP will commence. When the “Uninstall
Complete” message appears click the Done button.” on page 18.

6. Restart the RIP. Check in the Harlequin MultiRIP > Configure RIP > Extras dialog, and the Trial
options will no longer be displayed.

If you need to re-enable the trial options within the time frame of the trial period, you may place
the password and permit files back into the folders from which they came.
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I | Expiring licenses

The HLS governs when a license is considered to be expiring according to the following rules:
e ifinits last 7 days for durations of up to 70 days

e ifinits last 14 days for durations up to 140 days

e ifinitslast 31 days for longer durations.

As an aid the following messages are displayed in an Expiring Licenses dialog when the RIP is first
started:

RIP license will expire in 7 days, RIP license will expire in 6 days, and so on.
RIP license expires tomorrow

RIP license expires today

RIP license has expired.

Similar messages will appear for Try Before You Buy permits.

12 Installing plugins

A separate installer is provided for a number of plugins.

To run the installer:

1. Double-click Install_Plugins_win32.exe or Install_Plugins_winé4.exe depending on your platform.
2. Click Next to move onto the next screen or Previous to return to a previous screen.

3. With the Choose Install Folder window displayed use the Choose button to select the RIP to
which you want to add the plugins. If required, click Restore Default Folder to re-display the
default location. when the folder is selected click Next.

Note: If you select an incorrect folder, have already installed the plugin or the RIP in the selected
folder is running, an error message is displayed.

4. In the Choose Plugins screen click the check box of the plugins you want to install. The output
plugins available are CIP3, OKI C9650, OKI C931, OKI C941 and TIFF/IT. The NTPrint input
plugin allows Open Prepress Interface (OPI) servers or other applications to supply data to the
Harlequin MultiRIP via named pipes. When you have made your selections click Next.

5. Inthe Output Plugin License Agreement screen read the agreement. If you accept the terms select
that option followed by Next.

6. The Pre-Installation Summary screen shows your selected options. Use the Previous option to
make amendments to your selections. When your selections are correct click Install to start the
installation.

7. The progress of the installation is indicated with a progress bar. On completion click Done.
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Portions Type 1 font renderer contains licensed third party software

Portions copyright 1991 International Business Machines, Corp.,

Portions copyright 1991 Lexmark International, Inc.

Portions Adobe Glyph List. Copyright 1990-2007 Adobe Systems Incorporated.
Portions Adobe Cmaps. Copyright 1990-2009 Adobe Systems Incorporated
Portions TrueType ® font renderer copyright 1997 Bitstream, Inc.

Portions developed using the Kakadu software. Copyright 2001 David Taubman, The University of New South
Wales (Unisearch Ltd)

The ECI and FOGRA ICC color profiles supplied with this Harlequin RIP are distributed with the kind permis-
sion of the ECI (European Color Initiative) and FOGRA respectively, and of Heidelberger Druckmaschinen AG
(HEIDELBERG).

The IFRA ICC profiles supplied with this Harlequin RIP are distributed with the kind permission of IFRA and of
GretagMacbeth.

Harlequin and the Harlequin RIP are trademarks of Global Graphics Software Ltd, which may be registered in
certain jurisdictions. Harlequin ColorPro, Harlequin Dispersed Screening (HDS), Harlequin Precision Screening
(HPS), TrapPro, SetGold, SetGoldPro, Harlequin MultiRIP, Harlequin Host Renderer, Harlequin Parallel Pages
and Harlequin VariData are all trademarks of Global Graphics Software Ltd. Other brand or product names are
the registered trademarks or trademarks of their respective holders.

TrueType is a registered trademark of Apple Computer, Inc.
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Microsoft, Win32, Windows, Windows NT, Windows Server, Windows Vista, Windows 7, Windows 8 and WinFX
are either registered trademarks or trademarks of the Microsoft Corporation in the United States and/or other
countries.

PANTONE® Colors displayed herein may not match PANTONE-identified standards. Consult current PAN-
TONE Color Publications for accurate color. PANTONE® and other Pantone trademarks are the property of Pan-
tone LLC. © Pantone LLC, 2014.

Fonts copyright (c) 2000-2004 Timo Lehtinen. All Rights Reserved. http://www.timolehtinen.com/type/.

International Cooperation for Integration of Processes in Prepress, Press and Postpress, CIP4, Job Definition For-
mat, JDF and the CIP4 logo are trademarks of CIP4.

Adobe, Adobe Photoshop, Adobe Type Manager, Acrobat, Display PostScript, Adobe Illustrator, PostScript, Dis-
tiller and PostScript 3 are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries which may be registered in certain jurisdictions.

Portions include software licensed under the following terms:

OpenSSL - general purpose cryptography library
Copyright © 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledg-
ment: “This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.
(http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact openssl-
core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in their names
without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes
software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "ASIS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL
PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes
software written by Tim Hudson (tjh@cryptsoft.com).

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was
written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are adhered to.
The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code;
not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright
terms except that the holder is Tim Hudson (tjh@cryptsoft.com).
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Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this
package is used in a product, Eric Young should be given attribution as the author of the parts of the library used.
This can be in the form of a textual message at program startup or in documentation (online or textual) provided
with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following dis-
claimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol-
lowing disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledge-
ment: “This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)” The word
'cryptographic’ can be left out if the routines from the library being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code)
you must include an acknowledgement: “This product includes software written by Tim Hudson (fh@crypt-
soft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBU-
TORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUEN-
TIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this code cannot be changed.
i.e. this code cannot simply be copied and put under another distribution licence [including the GNU Public
Licence.

ICU - IBM library providing Unicode and Globalization support
Copyright © 1995-2003 International Business Machines Corporation and others All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the “Software”), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice
appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear
in supporting documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTIC-
ULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPY-
RIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY
SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to
promote the sale, use or other dealings in this Software without prior written authorization of the copyright
holder.

Expat - XML parser library
Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright © 2001, 2002 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated doc-
umentation files (the “Software”), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to per-
mit persons to whom the Software is furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CON-
NECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

pthreads-win32 - a POSIX threads library for Microsoft Windows
This file is Copyrighted

zlib - general purpose compression library
Copyright © 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held
liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to
alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original soft-
ware. If you use this software in a product, an acknowledgment in the product documentation would be appreci-
ated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
software.

3. This notice may not be removed or altered from any source distribution.

Copyright © 2005-2008, The Android Open Source Project

Licensed under the Apache License, Version 2.0 (the “License”); you may not use this file except in compliance
with the License.

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed
on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and limitations under the License.

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.

“License” shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1
through 9 of this document.

“Licensor” shall mean the copyright owner or entity authorized by the copyright owner that is granting the
License.

“Legal Entity” shall mean the union of the acting entity and all other entities that control, are controlled by, or are
under common control with that entity. For the purposes of this definition, “control” means (i) the power, direct
or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) owner-
ship of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

“You” (or “Your”) shall mean an individual or Legal Entity exercising permissions granted by this License.

“Source” form shall mean the preferred form for making modifications, including but not limited to software
source code, documentation source, and configuration files.

“Object” form shall mean any form resulting from mechanical transformation or translation of a Source form,
including but not limited to compiled object code, generated documentation, and conversions to other media

types.
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“Work” shall mean the work of authorship, whether in Source or Object form, made available under the License,
as indicated by a copyright notice that is included in or attached to the work (an example is provided in the
Appendix below).

“Derivative Works” shall mean any work, whether in Source or Object form, that is based on (or derived from)
the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a
whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works
that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works
thereof.

“Contribution” shall mean any work of authorship, including the original version of the Work and any modifica-
tions or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclu-
sion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the
copyright owner. For the purposes of this definition, “submitted” means any form of electronic, verbal, or written
communication sent to the Licensor or its representatives, including but not limited to communication on elec-
tronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of,
the Licensor for the purpose of discussing and improving the Work, but excluding communication that is con-
spicuously marked or otherwise designated in writing by the copyright owner as “Not a Contribution.”

“Contributor” shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has
been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants
to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce,
prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such
Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to
You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section)
patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such
license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their
Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s)
was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a
lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory
patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as
of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any
medium, with or without modifications, and in Source or Object form, provided that You meet the following con-
ditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trade-
mark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to
any part of the Derivative Works; and

(d) If the Work includes a “NOTICE” text file as part of its distribution, then any Derivative Works that You dis-
tribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding
those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within
a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if pro-
vided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever
such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only
and do not modify the License. You may add Your own attribution notices within Derivative Works that You dis-
tribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribu-
tion notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different
license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Deriva-
tive Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with
the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted
for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without
any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the
terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or
product names of the Licensor, except as required for reasonable and customary use in describing the origin of
the Work and reproducing the content of the NOTICE file.
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7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work
(and each Contributor provides its Contributions) on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDI-
TIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are
solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks
associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract,
or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in
writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or
consequential damages of any character arising as a result of this License or out of the use or inability to use the
Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunc-
tion, or any and all other commercial damages or losses), even if such Contributor has been advised of the possi-
bility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You
may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obliga-
tions and/or rights consistent with this License. However, in accepting such obligations, You may act only on
Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to
indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against,
such Contributor by reason of your accepting any such warranty or additional liability.

US Government Use

Harlequin MultiRIP software is a computer software program developed at private expense. If the Harlequin
MultiRIP software is acquired under the terms of a proposal or agreement with the United States Government or
any contractor therefor, the software is subject to the following restricted rights notice: “This Software is commer-
cial computer software provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the U.S. Govern-
ment is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer
Software clause at DFARS 252.227-7013, FAR 52.227-17 Alternate III (g)(3), or subparagraphs (c)(1) and (2) of the
Commercial Computer Software -- Restricted Rights at 48 CFR 52.227-19, as applicable, and their successor provi-
sions. Contractor/Manufacturer is Global Graphics Software Incorporated, Waltham, MA 02451.”
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